Customer Satisfaction

If you discover physical defects in the manuals distributed with an Apple product,
Apple will replace the documentation at no charge to you during the 90-day period
after you purchased the product
In some countries the replacement period may be different; check with your authorized
Apple dealer. Return any item to be replaced with proof of purchase to Apple or an
authorized Apple dealer.

Limitation on Warranties
and Liability

Even though Apple has tested the products described in this manual and reviewed
its contents, neither Apple nor Its suppliers make any warranty or representation,
either express or implied with respect to this manual. As a result, this manual is sold
"as is," and you the purchaser are assuming the entire risk as to its quality. In no
event will Apple or its suppliers be liable for direct, indirect, incidental, or
consequential damages resulting from any defect in the manual, even if they have
been advised of the possibility of such damages. In particular, they shall have no
liability for any programs or data stored in or used with Apple products, including the
costs of recovering or reproducing these programs or data. Some states do not allow
the exclusion or limitation of implied warranties or liability for incidental or
consequential damages, so the above limitation or exclusion may not apply to you

Copyright

This manual is copyrighted by Apple with all rights reserved. Under the copyright
laws, this manual may not be copied, in whole or part, without the written consent of
Apple. Under the law, copying includes translating into another language.

Product Revisions

Apple cannot guarantee that you will receive notice of a revision to the product
described in this manual, even if you have returned a registration card received
with the product. You should periodically check with your authorized Apple Dealer.
Copyright 1984, Apple Computer, Inc.
Apple Computer. Inc. 1984
20525 Mariani Avenue
Cupertino, California 95014
(408) 996-1010
Apple,the Apple logo, ProDOS� and MousePaint are registered trademarks of Apple
Computer, Inc. Simultaneously published in the U.S.A and Canada All rights
reserved.

Warning

This equipment has been certified to comply with the limits for a Class B computing
device, pursuant to Subpart J of Part 15 of FCC Rules Only peripherals (computer
input/output devices. terminals, printers, etc.) certified to comply with the Class B limits
may be attached to this computer. Operation with non-certified peripherals is likelv to
result in interference to radio and TV reception.

http://www.cvxmelody.net/AppleUsersGroupSydneyAppleIIDiskCollection.htm
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II Radio Frequency Interference Statement
The equipment described in this manual generates and uses
radio-frequency energy. If it Is not Installed and used properly, that
is, in strict accordance with our instructions, it may cause
interference with radio and television reception.
This equipment has been tested and complies with the limits for a
Class B computing device in accordance with the spacttlcattonsln
Subpart J, Part 15, of FCC rules. These rules are designed to
provide reasonable protection against such interference In a
residential installation. However, there is no guarantee that the
interference will not occur in a particular Installation, especially if
you use a "rabbit ear" television antenna. (A "rabbit ear" antenna
is the telescoping-rod type usually contained on TV receivers.)
You can determine whether your computer is causing interference
by turning it off. If the interference stops, it was probably caused
by the computer or its peripheral devices. To further isolate the
problem:
• Disconnect the peripheral devices and their Input/output cables
one at a time. If the interference stops, it is caused by either the
peripheral device or its 1/0 cable. These devices usually require
shielded 1/0 cables. For Apple peripheral devices, you can
obtain the proper shielded cable from your dealer. For nonApple peripheral devices, contact the manufacturer or dealer
for assistance.
If your computer does cause interference to radio or television
reception, you can try to correct the interference by using one or
more of the following measures:
• Turn the TV or radio antenna until the interference stops.
• Move the computer to one side or the other of the TV or radio.
• Move the computer farther away from the TV or radio.
• Plug the computer into an outlet that is on a different circuit
than the TV or radio. (That is, make certain the computer and
the radio or television set are on circuits controlled by different
circuit breakers or fuses.)
• Consider installing a rooftop television antenna with coaxial
cable lead-in between the antenna and TV.
If necessary, you should consult your dealer or an experienced
radio/television technician for additional suggestions. You may
find helpful the following booklet, prepared by the Federal
Communications Commission:
"How to Identify and Resolve Radio-TV Interference Problems"
This booklet is available from the U.S. Government Printing Office,
Washington, DC 20402, stock number 004-000-00345-4.

Radio Frequency Interference Statement

(1)

This manual tells you all about installing and using your AppleMouse.
Here is a summary:
• Chapter 1 introduces you to the mouse and tells you some of the
things it can do.
• Chapter 2 presents detailed instructions for hooking your mouse
up to your Apple lie computer.
• Chapter 3 explains MousePaint, a fascinating graphics program
included in your mouse package.
• Chapter 4 tells you how to take care of your mouse.
You can hook up and enjoy your mouse without knowing anything
about programming. However, if you are a programmer, you will find
Appendix A useful. Appendix A contains instructions and sample
routines if you want to write your own mouse programs in BASIC.
Captions, definitions, and other short
items appear in marginal notes like
this.

Throughout this manual, you'll see the symbols explained below. Pay
particular attention to the information in the paragraphs identified by
these symbols.
Gray boxes contain especially useful or interesting information.

..

Warning
Warning boxes indicate potential problems or hazardous situations
in which you can damage or destroy programs or information.

About This Manual
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........

The AppleMouse (Figure 1-1) is a hand-held device, connected to
your Apple lie computer by a flexible cable. As you move your mouse
about on the table next to your computer, it makes a cursor move in
exactly the same way on your monitor screen. By moving the cursor
to different symbols on the screen, you can tell your Apple lie what
you want it to do. The Apple Mouse represents one of the simplest
and most versatile computer input devices available today.
Figure 1-1. AppleMouse

Button----------

Mouse Programs

Your mouse requires special software. It works only when you have
loaded your computer with a program that has been written for it.
One such program, MousePaint™ Drawing Program (we'll call it
Mouse Paint for short), is on the disk that came packed with your
AppleMouse. It provides a fun way for you to get experience handling
your mouse. Other AppleMouse programs are being issued
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constantly; check with your Apple dealer for details. If you understand
programming, you can even write your own mouse programs;
Appendix A in this manual will get you started.

Caution: When you buy programs to use with your mouse,
make sure that they are designed to be compatible with the
Apple Mouse.
A Few Mouse Tricks

The AppleMouse gives you an entirely new way to control your
Apple lie computer. Instead of typing commands from the keyboard,
you can now interact directly with your monitor screen. You can
see exactly what you are doing as you do it.
You can do things with your mouse that would be impractical with
keyboard entries. For instance:
• You can create pictures directly on the screen, as if your hand
were holding an artist's pencil.
• You can select menu options simply by moving the screen cursor
to them, instead of having to type identifying codes.
• You can move text or graphic elements around on the screen.
All these techniques (and more) are illustrated in MousePaint, the
graphics program that comes with your mouse.
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• Connecting the Mouse
To start the fun, you'll need to connect the AppleMouse to your
Apple lie computer.
1. Make sure that your computer is switched off before you begin.
2. On the back of your computer, find the first port on the left (as you
face the back of the computer). It is labeled with the pictures of a
joystick and a mouse. Plug the mouse cable connector into this
port as you shown in Figure 2-1.
3. Secure the cable connector to your computer by finger tightening
its thumbscrews.
Figure 2-1. Connecting the Mouse
to the Apple llcComputer
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Next, you'll need to give your mouse some room to run in.

• Your Mouse's Working Area
Because you use your mouse by moving it around on the table top,
you will need to set up a working area for it. Here are some pointers.
• Your mouse's working space should be right next to your Apple.
About a foot (30 cm) square of empty table top will do nicely. Make
sure that it is flat and clean.
• You can move your mouse with either hand. Its 4-foot cable lets
you put it on either side of your Apple lie.
• The rubber ball on the bottom of the AppleMouse grips most
surfaces. But occasionally it may encounter a table top that is too
smooth to turn it properly. If this happens, just put down a large
sheet of paper under your mouse.
• Give your mouse a clean habitat. Be careful not to let it run through
wet or oily spots, dust, grit, eraser bits, cookie crumbs, or any
other material that it might pick up. Such stuff can get carried
inside, where it may gum up the works. For cleaning instructions,
see Chapter 4.
•

"al

Warning
It is possible for the small plastic pads on the underside of the
Apple Mouse to mar the surface they run on. Before operating your
mouse on highly polished furniture, lay down a paper covering to
protect the finish.
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Packed with your AppleMouse is a program disk called MousePaint.
It provides a fun way for you to get experience handling your mouse.
MousePaint turns your monitor screen into an artist's canvas where
you can make drawings, lettering, and diagrams. You can change,
move, erase, and redraw until you have created the picture you want;
then you can store it on a disk or print it on an Apple Printer.

• Getting Started
Put the Mouse Paint disk in the built-in disk drive of your Apple I le
computer and turn on the power. The drive will start whirring, and,
after a few seconds, a menu with three choices will appear on your
screen. Press (RETURN I to learn how to use your mouse.
Follow this self-guiding introduction carefully. It demonstrates several
important techniques for using your mouse:
• How to move the pointer around on your screen;
• How to click your mouse by placing the pointer over a screen
symbol and then pressing and releasing the mouse button;
• How to drag your mouse by moving it with its button held down;
• How to tell your computer what to do by selecting an option from a
Pull-Down menu.
• How to clean up your MousePaint display by using put-away
icons.
When you have finished the introduction, you will learn how to go to
the main MousePaint program. The MousePaint display will appear
on your screen, looking like Figure 3-1.
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Figure 3-1. The MousePaint Display

Pointer

Sketchpad

Drawing Tools------•

Enclosed Shapes-----•

Line Widths------••

• The MousePaint Display
The parts of the MousePaint display are labeled in Figure 3-1 and are
explained in detail later in this chapter. Here is a quick summary:
• The sketchpad is the area where you draw pictures. It starts as an
empty pattern. One of the first things you will do is tell Mouse Paint
to place a blank screen on it so you can start drawing.
• You use the Pull-Down menus to bring lists of MousePaint
commands to the screen. These commands help you save your
pictures on disk, cut and paste parts of them, select typestyles,
and soon.
• You fetch the MousePaint drawing tools by means of their
symbols-a pencil, a spray can, a brush, an eraser, and so on.
• The five pairs of enclosed shapes help you draw geometric
figures. Each one has an outline form and a solid form.
• When you ask MousePaint to draw a line, you can specify its
thickness by selecting one of the line widths.
• When you draw a solid figure, you can fill it with any one of the
patterns shown in the pattern boxes.
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• Somewhere on the display is a pointer. You move this around
when you move your mouse.
MousePaint's drawing tools all have names and specific functions:
• The grabbing hand moves your picture around so you can work
on different parts of it.
• The editor's box lets you mark off any part of your picture for
modification by one of the Edit Menu commands.
• The pencil lets you sketch freehand lines.
• The text letter adds neat lettering to your drawings.
• The spray can helps you produce shading on your drawings.
• The brush draws a swath of black in your choice of widths.
• The straight edge helps you draw straight lines.
• The eraser rubs out unwanted parts of your pictures.

• Making a Picture
Once the MousePaint display is on your screen, you are ready to
create pictures. For starters, try drawing a box and writing your
initials inside it. Here's how:

Getting a Blank Screen
1. Start out with the MousePaint display on your screen.
2. Roll your mouse until the pointer on the screen is on the Fi 1 e
menu head in the top line.
3. Pull down the File menu; that is, hold down the mouse button and
move the pointer downward.
4. Movethepointerto Blank HiRes Screen. Release the
button. A blank screen will appear on the sketchpad.

Selecting Line Width and Pattern
1. Move the pointer down to the third line width from the top in the
lower-left corner of the display. Click your mouse. The check mark
will move to the width you selected.

Making A Picture

2. Move the pointer to the fourth pattern box from the left in the
bottom row. Click your mouse. The pattern you selected will
appear in the box at the left end of the row.

Drawing a Shape
1. Move the pointer to the filled-in rectangular shape. It is half way up
the left side, just under the eraser. Click your mouse. A black box
will appear around the rectangle to show that it has been selected.
2. Move the pointer onto the sketchpad. Notice that it becomes a
cross. Starting from a point near the upper-left corner of the
sketchpad, drag your mouse (hold down the mouse button and
move the pointer) diagonally down to a spot near the lower-right
corner. MousePaint will draw a large rectangle as you go. It will be
filled with the pattern you selected, and bordered by the line width
you selected.

Using the Brush
1. Move the pointer to the brush symbol to the left of the sketchpad.
Click your mouse. The brush becomes light on dark to show that
you have selected it.
2. Move the pointer onto the sketchpad and inside the patterned
rectangle you just drew. Now write your initials on the pattern,
using your mouse. When you hold down the button, it's like putting
the brush down; when you release the button, it's like lifting the
brush. Don't worry if your writing is uneven or you make some
extra lines; this is just for practice.

Modifying Your Picture
1. Move the pointer to the editor's box in the upper-right corner of the
drawing-tools section to the left of the sketchpad (this is different
from the enclosed-shape box that you used before). Click your
mouse. The box becomes highlighted to show you it's working.
To drag the pointer, hold down the
mouse button and move the pointer
by moving the mouse.

2. Move the pointer back onto the sketchpad and drag it diagonally
over the first letter of your initials. Mouse Paint will draw the editor's
box around that letter.
3. Pull down the Edit menu to Invert and release the mouse
button. The part of your picture inside the editor's box will become
light on dark instead of dark on light.
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If your picture looks a trifle crude, remember that even Michelangelo
had to start somewhere. Now you're ready to explore MousePaint on
your own. In the rest of this chapter, you'll learn about some of the
things you can do with MousePaint.

• Drawing Tools
The following sections describe MousePaint's drawing tools.

-...--..-..-.---
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Grabbing Hand
The grabbing hand lets you push or pull fresh paper onto your
sketchpad. The space you see on your monitor screen is only a part
of the total page. To get more of it (or bring another part of a picture
into view), use the Grabbing Hand as follows:
1 . Click the hand symbol.
2. Move your mouse to any part of the sketchpad.
3. Drag (hold down the mouse button and move) the hand across any
part of the sketchpad.
You can push or pull the page in any direction; when you reach an
edge the page will stop moving. The hand does not need to be on
your drawing when you move your mouse because you are moving
the underlying page, not what's drawn on it.

Editor's Box
The editor's box marks off some part of your picture for further editing
action. Here's how to use it:
1. Click the broken-line box symbol.
2. Drag the pointer diagonally across the element you want to edit.
MousePaint draws a broken-line box around the element, with its
opposite corners where you start and end the move.
3. Move the pointer to Edit at the top of the Mouse Paint display.
Hold down the button to see the Edit menu.
4. Move the pointer down to the Edit command you want and release
the button. MousePaint will perform that function on the picture
element inside the box. Editing commands are described later in
this chapter.

Drawing Tools

Pencil
The pencil lets you make freehand drawings on your sketchpad:
1 . Click the pencil symbol.

2. Move your mouse on the sketchpad to wherever you want to draw
a line. When you press the button, you press the pencil against the
page to draw. When you release the button, you raise the pencil off
the page to move.

Note: The pencil writes either dark or light. Its color is the opposite
of the color of the background where it first started.

A

Text Letter
The text letter lets you add lettering to your picture. Here's how to
do it:
1 . Click the big A symbol.
2. Move the pointer to Fonts at the top of the MousePaint display.
Hold down the button to see the menu of typestyles.
3. Move the pointer down to the typestyle you want and release the
button.
4. Click your picture where you want your line of text to start.
5. Type the text you want on your keyboard.
You can move or edit lettering in your picture, just like any other
element.

Caution: MousePaint uses the same memory area for lettering as
for its Cut and Paste functions (see "Editing Commands" later in
this chapter). When you select a lettering font, any previously cut
clipping is destroyed.

Spray Can
The spray can helps you put shading on your picture:
1 . Click the sprayer symbol.
2. Drag your mouse on the sketchpad to lay down shading. When
you move over the same spot more than once, the shading gets
darker.
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Brush
The brush paints a swath of black in various widths. You choose a
brush and use it like this:
1 . Pull down the Aids menu and release the mouse button on
Set Brush. A display of brush types will appear.
2. Pick the style of brushwork you want by clicking one of the
symbols on the display.
3. Click the brush symbol in the drawing-tools section to the left of the
sketchpad.
4. Drag the brush on the sketchpad where you want the to paint.

Straight Edge
The straight edge draws a straight line at any angle, in various widths
and patterns. Here's how you use it:
1. Click the diagonal line symbol.
2. Click one of the line widths at the bottom left corner of the
Mouse Paint display.
3. Click a pattern box at the bottom of the MousePaint display. The
pattern you select will appear in the box at the far left. Select the
Plain b l ack box forasolidline.
4. Drag the pointer on the sketchpad approximately where you want
the line to be located. MousePaint will draw a neat, straight line of
the width and pattern you selected between the beginning and end
of the move.

Eraser
The eraser wipes clean any part of your drawing, quickly and easily:
1 . Click the eraser symbol.
2. Drag the eraser on the sketchpad wherever you want to erase.

• Enclosed Shapes
Below the drawing tools, on the left side of the Mouse Paint display,
are five pairs of shape symbols. Each has an outline form and a solid
form. When you select one of the shape symbols, Mouse Paint draws

Drawing Tools

a geometric figure on your sketchpad. If you choose the outline form,
it just draws the perimeter; if you choose the solid form, it fills it with
the currently selected pattern. Here's how to draw an enclosed
shape:
1. Click the symbol for the kind of shape you want: rectangle,
rectangle with rounded corners, oval/circle, free form, or polygon.
2. Click the line width you want for its perimeter, choosing from the
selection at the lower-left corner of the Mouse Paint display.
3. Click a pattern at the bottom of the MousePaint display. If you
select an outline form, MousePaint will use this pattern for the
border; if you select a solid form, MousePaint will fill the inside with
it.
4. Depending on the shape you chose, define its size and position on
your sketchpad by one of the procedures that follow.
For rectangles, drag the pointer along a diagonal line. Mouse Paint
will construct a rectangle with opposite corners at the beginning and
end points of the move.
For rounded-corner boxes, do the same as for rectangles. The
corner radius is the same for all sizes.
For circles and ovals, drag the pointer as if you were making a
rectangle. MousePaint draws the largest circle or oval that will fit
inside the rectangular space you have defined.
For free-hand shapes, drag the pointer around the outside of the
shape you wish to draw.
For polygons, click your mouse at each corner.

• Editing Commands
MousePaint's Editing commands let you manipulate large chunks of
your picture-move them, duplicate them, delete them, or modify
them. They operate only on the part of your picture that you have
previously enclosed in the editor's box. Here are the details:

Move
To move any part of your picture to another place on the sketchpad,
just do this:
1. Enclose in the editor's box the part of your picture you want to
move.
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2. Place the pointer inside the editor's box and move your mouse.
The editor's box and its contents will move with the mouse.
Caution: As long as you hold down the mouse button, you can

move the editor's box over other parts of your picture. When you
release the mouse button, MousePaint erases everything covered
by the box.

Cut and Paste
The Editor's Cut command scissors out the part of your picture that's
in the editor's box. The resulting clipping is not destroyed, however;
MousePaint stores it in memory. When you select the Paste
command, the clipping is glued back into your picture at the place you
specify. Here's how to cut:
1. Click the editor's box symbol (it's in the upper part of the drawingtools section).
2. Drag the pointer diagonally over the part of your picture you want
to cut out. Mouse Paint will draw the editor's box around it.
3. Pull down the Edit menu and select Cu t. The material inside
the editor's box will disappear.
To paste a clipping you have just cut into a new location, do this:
1. Pull down the Edit menu and select Paste.
2. Move the pointer (which now becomes a pointing finger) to any
position on the sketchpad.
3. Click your mouse. The previously cut clipping will materialize on
the sketchpad at the end of the finger.
You can paste any number of copies of one clipping in different
places.
Caution: If you select two Cut commands in a row, the clipping

from the first one will be lost. Only the most recently cut clipping is
held.

Copy
The Editor's Copy command duplicates the part of your picture that's
in the Editor's box, without removing the original. You use it in the
same way as the Cut and Paste command, but the original remains
behind on the sketchpad.

Editing Commands

Delete
The Editor's Delete command erases everything inside the editor's
box:
1. Enclose in the editor's box the part of your picture to be deleted.

2. Pulldownthe Edit menuandselect Delete.
Did you just say "Oops"? Then use the Editor's Undo command
(explained later in this chapter) to put it all back.

Invert
The Editor's Invert command changes all the white parts inside the
editor's box to black, and all the black parts to white:

1. Enclose the part of your picture to be inverted in the editor's box.
2. Pull down the Edit menu and select I mi e rt.

Flip Horizontally and Vertically
The Editor's flip commands turn over the part of your picture inside
the editor's box, creating a mirror image. F 1 i P Horizon ta 11 }'
trades right and left; F 1 i P 1,1 e rt i ca 11 }' trades top and bottom:

1. Enclose the part of your picture to be flipped in the editor's box.
2. Pulldownthe Edit menuandselect FliP Ho r i z o n t a l Lv
or FliP 1,Jerticalb'.

Undo
The Editor's Undo command reverses the last action you took,
returning your picture to its previous state. Just pull down the Edit
menu and select Undo. You must use this command right away,
however-it works only on the very last thing you did.

• Drawing Aids Commands
MousePaint's Aids menu contains several commands that help you
make neat, detailed drawings.

Chapter 3: MousePaint

FatBits
The FatBits command creates an enlarged view of a small part of
your picture, each point of which appears as a separate black
square. With FatBits, you use the MousePaint drawing tools to make
finely detailed changes. You can create or erase individual points by
clicking the pencil on them, fill precise areas with the brush or spray
can, or edit small regions. You can also create any of MousePaint's
enclosed shapes in miniature. All the changes you make will be
faithfully incorporated into the original sketchpad image. Here's how
to use the FatBits command:
1. Using the Grabbing Hand, move part of your picture in the upperleft corner of the sketchpad.
2. Pull down the Aids menu and select Fa tB its.
3. Select one of the MousePaint shapes or drawing tools, as
explained earlier in this chapter.
4. Follow the procedure for the shape or drawing tool you selected,
working on the enlarged view.
When you have finished with FatBits, just click Fa tB its on the
Aids menu a second time.

Show Page
The Show Page command creates a miniature image of your entire
picture, including parts that are not currently in view. This lets you
check your picture as a whole. It's simple:
1. Pull down the Aids menu and select Show Pa s e , The
miniature page will appear.
2. To move the miniature page around, place the pointer on the
highlighted heading, Sh 01..i Pa se , and drag (hold down the
mouse button and move) the page.
3. When you are finished viewing the whole page, click your mouse
on the rectangle in its upper-left corner.

Drawing Aids Commands

Set Brush
The Set Brush command allows you to select the kind of line the
brush will paint. Here's how:
1. Pulldownthe Aids menuandselect Set Brush.
2. Click one of the brush styles shown on the menu.

Grid
The Grid command adjusts the positions of lines and enclosed
shapes as you create them, so that they always fall on a set of
invisible grid lines. This helps keep your drawing neat; you don't have
to worry about positioning everything exactly right. You start and stop
the Grid command by pulling down the Aids menu and clicking
Grid. It keeps working until you tell it to stop.

Caution: If you use Fatb its with the grid on, the pencil (and
other tools) will not work as you might expect. Be sure to click
G r i d to turn it off when you no longer need it.

II Filing Commands
Once you have created the picture you want, MousePaint provides a
variety of commands to help you store it or print it.

Blank Screens
MousePaint gives you a choice of blank screens to put on your
sketchpad. They are listed on your sketchpad. To fetch one, just pull
down the Fi 1 e menu and release the mouse button on your
selection.

•

Warning
Whenever you fetch a blank screen, the picture on your previous
screen is destroyed. If you want to preserve your picture in a disk
file, use the Fi le menu command, Put a CoPY In, first.

Disk Names and Filenames
MousePaint uses the same file-naming rules as does Apple Prooos··.
If you are not familiar with ProDOS ". here's an abbreviated summary:
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Acceptable Names
When you format a storage disk, MousePaint asks you what to name
that disk. When you create a new file on a storage disk, MousePaint
asks you for a filename. In either case, you must think up a name that
conforms to all of the following rules:
• The name must begin with a slash followed by a letter.
• It can contain only letters, numbers, and/or periods.
• It must not be longer than 15 characters.
Here are some example names that conform:
/PRODOS.NAMES.15
/0510414
/FILE.NAME
/A

•

Warning
It is a good idea to write down your disk name and all its filenames
on the disk's label. If you forget them and can't type them on
your keyboard, MousePaint will be unable to fetch the
corresponding files. You can use your ProDOS User's Disk to
catalog your disk if you forget the filenames.

Calling a File
Whenever you create a new Mouse Paint storage file, or retrieve or
delete an old one, you must type its complete name on your Apple lie
keyboard. The complete name consists of the disk name followed by
the filename. You must use the disk name; a disk drive designation
(such as ",01" or "#4:") won't work.
Here are some examples of correct ways to designate MousePaint
files:
/DISKNAME/FILENAME
/DISK.1/FILE.305
/MOUSEDRAWINGS/0.MARSON
/A/A
/MY.CARTOONS/FELIX. THE.CAT
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Here are some examples of disk names and filenames that won't
work with MousePaint:
DISKNAME/FILENAME
(Disk name does not begin with /)
/DISK NAME /FILE NAME
(Spaces not allowed)
/DISKNAME/305.FILENAME
(/ must be followed by a letter)
/A.LONG.DISK.NAME/FILENAME (Disk name too long).

Formatting a Storage Disk
To save your MousePaint picture, you must store it on a disk with a
special format. The Format Disk command converts ordinary flexible
disks into MousePaint-formatted disks.

Note: MousePaint uses the Apple ProDOS operating system. If
you have the ProDOS software, you can use it to format
MousePaint disks and manipulate MousePaint files.
Here's how to format a disk to accept MousePaint files:

.A

Warning
Formatting a disk destroys all the files that were previously on it.
Are you sure you want to do that? Be careful not to format your
MousePaint disk accidentally.
1. Pulldownthe File menuandselect Fo rma t Disft.
2. Remove the MousePaint disk from your built-in disk drive.
3. Place the disk you want to format in the built-in drive, where the
Mouse Paint disk was.
4. On your Apple lie keyboard, type the name you want to give your
storage disk. Follow the rules given earlier in this chapter in the
"Disk Names and Filenames" section.
5. Press (RETURN! on your keyboard. Your disk drive will
whirr for several seconds while it formats the disk.
6. Remove the formatted disk and replace the MousePaint disk.
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Put a Copy In
The Put a Copy In command is used to save a picture. When used it
creates a new disk file containing a copy of the picture that's on the
page. You do it this way:
1. Be sure you have a ProDOS-formatted disk in your built-in drive.
2. Pulldownthe File menuandselect Put a CoP>' In,,,
3. MousePaint places a new line at the top of the screen, saying
Save as file na1,1ed,,, Typethefilenameunderwhich
you want to store your picture (including the disk name). If you're
not sure how to create a Mouse Paint filename, see the section
"Disk Names and Filenames" earlier in this chapter.
4. Press (RETuRNl. MousePaint opens a new disk file and stores your
picture in it.
You can also use this command to duplicate a file, giving it a different
name.

Get Picture
The Get Picture command fetches a picture that you previously
stored on disk and places it on the MousePaint sketchpad. Here's
how to retrieve a picture from your files:
1. Make sure your ProDOS-formatted storage disk is in your built-in
disk drive.
2. Pull down the File menu and select Get Picture •• ,
3. MousePaint places a new line at the top of the screen, saying
Get Picture na111ed,,, Typethenameofthefilethatyou
want to retrieve (including the disk name), and then press [RETURN!.
4. MousePaint will fetch the file and copy it onto the sketchpad.

..

Warning
Whenever you get a new picture, the work presently on your
sketchpad is erased.
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Put Back Picture
The Put Back Picture command updates the disk file from which
you originally fetched a picture by storing the current state of the
MousePaint sketchpad under the same name. It thus overwrites the
original file with the current picture. This command provides a handy
way to save your work periodically as you are creating a picture. It's
simple to do:
1. Make sure the disk that your current picture came from is still in
your built-in disk drive.
2. Pulldownthe File menuandselect Put BacK Picture.
MousePaint will find the original disk file and update it.
3. Wait until the disk drive light has gone out before resuming work
on your sketchpad.

Delete File
The Delete File command erases a picture stored on disk. Here's
how to do it:
1. Make sure the file you want to delete is on a disk in your built-in
disk drive.
2. Pull down the File menu and select De 1 et e Fi 1 e •••
3. Mouse Paint places a new line at the top of the screen, saying
De 1 ete f i 1 e n ame d . • • Type the name of the file you want
to delete, including its disk name, and press (RETURN).
4. MousePaint will erase that file.
If you change your mind and want to cancel the Delete command
(before completing step 3), just click your mouse.

Print Picture
The Print Picture command sends the picture on the MousePaint
sketchpad to an Apple lmagewriter or other Apple printer. If you have
one of these devices in your Apple system, it's easy to make a paper
copy of your current artwork:
1. Make sure that your printer is turned on and has fresh paper.
2. Pull down the File menu and select Print Picture.
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3. MousePaint places a new line at the top of the screen, asking you
what slot number your printer is connected to. Type slot number 1
(this is really the connector number which your printer should hook
up to), and press (RETURN I.
4. Mouse Paint sends commands to your printer, telling it how to
create a dot-by-dot copy of the image on the sketchpad.
Wait until your printer is finished before working further with
MousePaint. Some pictures may take several minutes to print.
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As you push your mouse about on the table, the ball on its underside
may pick up dirt and carry it inside. To clean your mouse, just do the
following:
1. Turn your mouse over. On its tummy you will see a black, plastic
disc with a hole in its center. The disc has a round mark near its
edge, which should be opposite the letter L (for locked) engraved
in the mouse. See Figure 4-1.
Figure 4·1. The Underside of
Your Mouse

2. Pressing down on the disc, turn the black disc counterclockwise
one-eighth of a turn as shown in Figure 4-2. This will bring the
mark on the disc opposite the letter O (for open).
3. Cup your hands around the mouse and turn it right side up. The
black disc will fall out, and with it the ball (see Figure 4-3).
Figure 4-2. Unlocking the Disc

Figure 4·3. Removing the
Disc and Ball

4. Wipe the ball clean. If it is greasy, wash it with warm, soapy water,
and dry it thoroughly with a lint-free cloth.
5. Turn the mouse back upside down. If there is any material in the
hole on its bottom, gently pick it or shake it out. Do not try to blow it
out. This may just drive the material farther inside. Do not attempt
to wash out the cavity or use solvents on it.
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6. Place the clean ball back into its hole in your mouse's tummy.
7. Replace the black, plastic disc, orienting it so that the spot on
its rim is near the letter 0. Pressing down on the disc, turn it
one-eighth of a turn clockwise, bringing the spot to the letter L.
This should lock the disc in place.
8. Turn the mouse right side up. It is ready for use again.
This is about all the care your AppleMouse needs. If you keep it clean
and don't drop it, it will function for many years.
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If you understand BASIC (Beginner's All-Purpose Symbolic
Instruction Code), you will find it easy to write programs that work

with your AppleMouse. This appendix tells you how.

• The BASIC Mouse
In a BASIC program, your AppleMouse acts like any other peripheral
device-like a printer or a disk drive. You activate it with a PR#
command and then extract information from it with an IN# command
followed by INPUT. It returns information about its location and button
status in the form of a sequence of numbers.

Calling Your Mouse
The AppleMouse is treated as a device in slot 4, even though your
Apple lie has no slots. The AppleMouse contains a permanent
program (firmware) that allows it to communicate with BASIC
programs. So to call the mouse from a BASIC program, you must first
start up the mouse's own internal program.
To do so, your BASIC program wakes up your mouse by sending
the startup message O 1 to its firmware, using the PR# command
followed by a PRINT statement. If you are running Apple DOS
or ProDOS, precede the PR# command with a CONTROL-D
(ASCII 04) character. You can do all this with the command
sequence
PR r NT CHR$ ( a>

;

11

PR#

a" :

PR r NT CHR$ < 1

>

This command sequence places the mouse in BASIC mode and
sets the mouse position numbers to zero. Don't forget to follow it by
PR I NT CHR$ <a> ; 11 PR# 0 11 if you are subsequently going to use
the screen for output.
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Reading the Mouse Position
After your BASIC program has started up the mouse, it can read the
mouse's position and button status (that is, whether the button has
been pressed) at any time by executing an IN# 4 command followed
by INPUT to three numeric variables. For instance, the sequence
Extracting Position and Button
Information

PRINT CHR$(ll);"IN# ll": INPUT

1111;

A, 8, C

places mouse position and button data into the numeric variables
A, 8, and C.
The numeric information returned by your AppleMouse in BASIC
mode has the following format:

A,8,+C
where
A
8

+

C

is the last X {horizontal) position of the mouse
is the last Y (vertical) position of the mouse
becomes - if a key on the keyboard has been pressed
indicates the status of the mouse button

A and 8 vary over the range Oto + 1023 (they are never negative).
Assuming the mouse is oriented with its tail away from you, A
increases as you move the mouse to the right; 8 increases as you
move the mouse toward you (away from its tail).
The status digit (C) returns a value in the range 1 through 4, plus or
minus, reporting both the present status of the mouse button and its
status the last time your program executed an INPUT command.
Table A-1 shows th meaning of each value of the status digit.
Table A-1. Status Digit Values

c

Current Reading

Last Reading

Pressed

Pressed

2

Pressed

Released

3

Released

Pressed

4

Released

Released

If you press any key on your Apple keyboard, the sign of C changes
from positive to negative. It stays negative until you reset it to positive
with the command

POKE -16368,0
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Turning off the Mouse
When your program is finished using the mouse, turn it off by sending
it the ASCII character 00. The BASIC commands are identical to
those that call the mouse (see the section "Calling Your Mouse"
earlier in this appendix), except that O is substituted for 1 in the
second PRINT statement:

PR I NT CHR$ ( a> ; "PR#

a" :

PR I NT CHR$ ( 0 >

• A Sample Program: MOUSE.MOVE
MOUSE.MOVE displays on your monitor screen the numbers (X, Y,
and S) generated by the AppleMouse. You can roll your mouse
around and watch the numbers change. To exit, press any key on
your Apple keyboard. Here's the listing:

10
20
30
a0
50
60
70
80

se
100
110
120
130

HOME
PRINT "This is a d emon s t ration of the
Mouse"
PRINT CHR$(a)
"PR#a" : PRINT CHR$(1)
PRINT CHR$(a)
"PR#0"
PRINT CHR$(a)
"IN#a"
INPUT"";
v, S
VTAB 10 : PRINT Xi" ",Y" ",S" 11
IFS> 0 THEN 60
PRINT CHR$ (a> ; "IN#0"
PR I NT CHR$ ( a> ; "PR#a" : PR I NT CHR$ < 0 >
PRINT CHR$ (a> ; "PR#O"
POKE -16368t 0 : REM CLEAR KEYBOARD STROBE
END

x.

Comments
Line 10 clears the screen to black.
Line 20 prints a heading message.
Line 30 starts up the mouse's internal program.
Line 40 establishes that subsequent PRINT commands will send
information to the monitor screen.
Line 50 establishes that the subsequent INPUT command will read
the mouse.

A Sample Program: Mouse.Move

Line 60 transfers mouse position and button status readings to the
numeric variables X, Y, and S.
Line 70 displays the numeric variables X, Y, and Son the 1 oth line of
the monitor screen.
Line 80 returns the program for more mouse data if no keyboard key
has been pressed. If a key has been pressed, the program drops to
line 90.
Line 90 re-establishes your keyboard as the input device.
Line 100 resets the mouse position data to zero.
Line 110 re-establishes the monitor screen as the output device.
Line 120 resets the keyboard strobe so that the next time a key is
pressed BASIC can check for it (see the Applesoft BASIC
Programmer's Reference Manual, Appendix F, section F.2 for
details).
Line 130 ends the program .

• A Sample Program: MOUSE.DRAW
MOUSE.DRAW allows you to use your mouse to make simple
drawings on your monitor screen in low-resolution graphics mode.
Pressing the mouse button clears the screen so that you can start
over. Pressing any key on your keyboard produces a prompting
message; you can reply by pressing either (RETURN) to continue or
(EscJ to terminate the program. Here's the listing:

10
100
110
120
130
lll0
150
160
170
180
180

REM Uses mouse to draw lo-res �raPhics
GOSUB 1000 : REM Turn on the mouse
PR I NT CHR$ ( a l ; " I N#ll"
INPUT
i }-(, Y, S
REM Read mcu s e data
IFS= 1 THEN 100 : REM Clear the screen
IFS< 0 THEN 300 : REM Time to quit?
REM Scale mouse Position
X = INT (XI 25.575)
Y = INT (YI 25+575)
PLOT X, Y
GOTO 120

300
310
320

REM Check if time to quit
POKE -16368, 0 : REM CLEAR KEYBOARD STROBE
PRINT CHR$ll) ; "IN#0"

1111
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330 l.JTAB 22 : PRINT "Press RETURN to cont or
ESC to =u i t II
POKE -16368,0
340 VTAB 22 : HTAB 38 : GET A$
GOTO 110
350 IF A$= CHR$(13) THEN HOME
380 IF A$<> CHR$(27) THEN 330
370 REM Clear screen and zero mouse
380 TE>(T : HOME
"PR•4" : PRINT CHR$(0)
390 PRINT CHR$(4)
400 PRINT CHR$(4)
PR•0"
410 END
1000 REM Clear screen and initialize mouse
1010 HOME : GR
1020 COLOR = 15
PRINT CHR$(1)
1030 PRINT CHR$(4)
"PR•4"
1040 PRINT CHR$(4)
PR•0
1050 RETURN
11

11

11

Comments
Line 10 reminds you what the program does.
Line 100 calls the subroutine at lines 1000 through 1050.
Line 110 establishes that the subsequent INPUT command will read
the mouse.
Line 120 transfers mouse position and button status data to the
numerical variables X, Y, and S.
Line 130 re-initializes the mouse if its button is pressed.
Line 140 sends the program to its exit routine if a key on the Apple
keyboard has been pressed.
Line 150 reminds you of what the next two lines do.
Lines 160 and 170 convert the range of mouse position numbers (0 to
1023) to the range of low-resolution graphics coordinates (0 to 40).
Line 180 plots a point on the monitor screen.
Line 190 sends the program back for more mouse data.
Line 300 reminds you what lines 310 through 400 do.
Line 310 resets the keyboard strobe so that the next time a key is
pressed BASIC can check for it (see the Applesoft BASIC
Programmer's Reference Manual, Appendix F, section F.2 for
details).

A Sample Program: Mouse.Draw

Line 320 tells the computer to accept input from its keyboard.
Line 330 prints prompting instructions on line 22 of the screen.
Line 340 fetches your answer to the prompt and changes the button
status number back to positive (it becomes negative whenever you
press a key on the Apple keyboard).
Line 350 sends the program back to reporting mouse data if you
pressed (RETURN).
Line 360 fetches another answer if you press any key except (Esc].
Line 370 reminds you of what happens next.
Line 380 cancels graphics mode and clears the screen.
Line 390 resets the mouse position data to zero.
Line 400 reestablishes the monitor screen as the output device.
Line 410 ends the program.
Line 1000 reminds you what the following subroutine does.
Line 1010 clears the monitor screen and sets up Apple's
low-resolution graphics mode.
Line 1020 establishes that the cursor will be white.
Line 1030 starts up the mouse's internal program.
Line 1040 establishes that subsequent PRINT commands will send
information to the monitor screen.
Line 1050 returns to the main program (line 110).
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